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2. Welcome to Komplete Kontrol
Komplete Kontrol organizes all your instruments, effects, presets, loops, and samples, smartly
mapping everything to your hardware so you can find, play, and tweak all your sounds in one place.
This free plug-in runs in any DAW and works seamlessly with any MIDI controller, or your mouse
and keyboard.

In the browser you will find presets from all of your Komplete instruments and effects, as well any
NKS-compatible plug-in installed on your computer. By using Komplete Kontrols intuitive tags and
filters, you can quickly find results that suit your musical goals.

With Play Assist, Komplete Kontrol gives you new and inspiring ways to perform. Map your
keyboard to any one of over 100 different scales and modes, play chords with one finger,
effortlessly create expressive arpeggios, and more.

This document shows you how to setup Komplete Kontrol and describes all features in detail,
starting with the overview.

Thank you for choosing Komplete Kontrol. We hope you enjoy it!

This document describes the Komplete Kontrol software. For information about your
Kontrol keyboard, refer to the hardware manuals available here:

• Kontrol S-Series Downloads
• Kontrol A-Series Downloads
• Kontrol M32 Downloads

WELCOME TO KOMPLETE KONTROL 2

https://www.native-instruments.com/products/komplete/keyboards/kontrol-s49-s61-s88/downloads/
https://www.native-instruments.com/en/products/komplete/keyboards/komplete-kontrol-a25-a49-a61/downloads/
https://www.native-instruments.com/en/products/komplete/keyboards/komplete-kontrol-m32/downloads/


Document Conventions
In this document the following formatting is used to highlight useful information:

Italics Indicates paths to locations on your hard disk or other storage devices.

Bold Highlights important names, concepts, and software interface elements.

[Brackets] References keys on the computer keyboard.

Denotes a single step instruction.

Denotes the expected result when following instructions.

The following three icons denote special types of information:

The light bulb icon indicates a useful tip, suggestion, or interesting fact.

The information icon highlights essential information in a given context.

The warning icon alerts you of potential risks and serious issues.
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3. Setting up Komplete Kontrol
The Komplete Kontrol software is installed both as a stand-alone application as well as
a VST, VST3, Audio Unit, and AAX plug-in. The Komplete Kontrol stand-alone application
directly communicates with your audio and MIDI interfaces, which you can configure in the
Komplete Kontrol Preferences. When Komplete Kontrol is used as a plug-in in a DAW, the
communication with your audio and MIDI interfaces is managed by the DAW.

By default, the Komplete Kontrol stand-alone application uses the standard audio interface of your
computer. In order to use another audio interface, and receive MIDI notes from your keyboard, you
need to configure the application in the Preferences.

Configuring the Audio Interface
1. In the Main menu click Edit > Preferences to open the Preferences.
2. Click Audio to display the Audio page.
3. Select the hardware driver supported by your audio interface from the Driver drop-down menu.
4. Select the audio interface from the Device drop-down menu.
5. Under Routings, select the left and right output channels that you want to use

for Komplete Kontrol’s master output in the Komplete Kontrol Out 1 L and
Komplete Kontrol Out 1 R drop-down menus.

Enabling MIDI Control
1. In the Main menu click Edit > Preferences to open the Preferences.
2. Click MIDI to display the MIDI page.
3. Click Input in the Devices section to display the available devices for incoming MIDI signals.
4. Click the Komplete Kontrol checkboxes to activate incoming MIDI signals from the keyboard.

→ The software is configured and ready to be controlled with the keyboard.
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4. Komplete Kontrol Overview
This section provides an overview of the main areas you will find in the Komplete Kontrol software.

1. Header: Provides access to general functions like the Main menu, the Preset display, the
transport and volume controls, as well as options to show and hide user interface areas. For
more information, refer to Header.

2. Plug-in chain: Enables you to load instruments (Plug-in slot 1) and effect plug-ins (Plug-in slot
2 onwards). For more information, refer to Plug-in Area.

3. Browser: Provides access to your instruments, loops, one-shots and effects. It also enables
you to add, edit, and manage your preset files. For more information, refer to Browser.

Header
The header is where you find general settings that affect Komplete Kontrol globally. It also lets you
access additional user interface areas.

1. Komplete Kontrol logo: Opens the About screen, which shows the version number of the
Komplete Kontrol software.
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2. Browser: Shows or hides the Browser. For more information, refer to Browser.
3. Main menu: Opens the Komplete Kontrol menu, which contains a number of general functions

and settings, including the Preferences.
4. Preset display: Displays the name of the loaded Preset file or KONTAKT key switch. The arrow

buttons on the right skip to the next Preset file in the Browser’s Results list.
5. Perform panel: Shows or hides the Perform panel, which gives you access to the parameters

of the Scale engine and the Arpeggiator. The Perform panel button lights up blue when the
Scale engine and/or the Arpeggiator are activated. For more information, refer to Using Scales
and the Arpeggiator.

6. Plug-in panel: Shows or hides the Plug-in panel, which allows you to customize the parameter
mapping for the Control section on the keyboard for every Preset file. For more information,
refer to Customizing Parameter Mappings using the Plug-in Panel.

7. Plug-in chain: Shows or hides the Plug-in chain and lights up white when activated. For more
information, refer to Plug-in Chain.

8. View: Switches between Default view and Additional view of the loaded Instrument. The View
button only appears if the loaded Instrument contains an Additional view. The View button is
not available when an Effect is selected.

9. MIDI/Keyboard: Shows the connected Komplete Kontrol keyboard. When multiple instances
of the Komplete Kontrol software are running in a DAW, clicking the button connects the
keyboard to this instance. If you are using a third-party controller, the MIDI button is shown
instead. Clicking the MIDI button opens the MIDI Learn panel that you can use to assign your
controller to Native Map. For more information, refer to Mapping MIDI Controls to Third-Party
Controllers.

10. Transport controls: Lets you start, stop, and reset the internal clock. When Komplete Kontrol
is loaded as a plug-in in a host, the transport automatically follows the host transport and this
feature is greyed out. For more information, refer to Transport and Tempo.

11. Tempo: Lets you adjust the tempo in BPM (beats per minute). For more information, refer to
Transport and Tempo.

12. Main Volume: Adjust the output level of Komplete Kontrol in 0.5 dB increments from -30 dB to
+10 dB. The meter shows the peak level of the output signal.

13. CPU meter: Represents the current load on your computer’s processor; it should not go above
70% to avoid clicks and interruptions.

14. NI logo: The NI logo opens the About screen, which shows the version number of the
Komplete Kontrol software.

Instrument Views
Many NKS instruments feature different views, giving you access additional functions and options.
Three views are available in Komplete Kontrol, Default View, Additional view, and Edit View.

• Default View appears when you load an NKS instrument in Komplete Kontrol. It gives you
access to key features with an easy-to-use interface.

• Additional View gives you access to additional controls, or a different set of controls, depending
on the instrument.

• Edit View is available for REAKTOR and KONTAKT instruments and gives you access to the full
feature set of the respective application.
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▶ To switch between Default View and Additional View, click the View button (+ icon) in the
Header.

Alternatively, you can switch between all instrument views using the Main menu. The available
views may vary depending on the loaded instrument.

▶ To switch between all available views for the loaded instrument, open the Main menu and
select Default View, Additional View, or Edit View from the View submenu.

Transport and Tempo
In the Komplete Kontrol stand-alone application, the transport and tempo controls enable you to
control the playback when using sequenced instruments or the arpeggiator. Additionally, the tempo
is used by instruments to synchronize rhythmic modulation and delay effects, for example.

The transport and tempo controls are part of the Header:

1. Play: Starts and stops the internal clock. This can be used to control the playback of
sequenced instruments.

2. Reset: Resets the internal clock to its start position. Consequently, sequencers in instruments
will start their playback from the beginning. The same applies to the arpeggiator.

3. Tempo: Sets the tempo in BPM (beats per minute).

When using Komplete Kontrol as a plug-in, it is automatically synchronized to the
DAW. Therefore the transport and tempo controls are grayed out and inactive.
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5. Browser
The Browser provides access to all your factory content (), as well as your own user content.
Sophisticated browser functionality allows you to filter sounds by tags, brand, product, bank, text
search, user presets and Favorites, helping you to quickly and intuitively find the right presets for
your musical needs.

▶ To open the Browser, click the Browser icon in the .

The Browser contains the following features and controls:

1. Browser button: Opens and closes the Browser.

2. Search field: Filters presets according to text entered in the field. The search engine considers
the preset name, author, Brand / Character / Sound Type tags, product and bank name. The
Results list is filtered according to the terms entered in the Search field. Refer to Using the
Search Field.

3. Product Type selector: Selects the type of products displayed in the Browser. Refer to
Selecting a Product Type.

4. Tag filters: Contains Brand, Sound Type, and Character filters, which use NKS tagging to
enhance the browsing experience. Switch between the three filters interchangeably and explore
tags that classify and organize presets based on the manufacturer as well as various musical
attributes and functions. You can hide these filters by clicking the arrow icon on the right to
minimize the filter section. Refer to Using Filters.

5. Product filter: Displays your as tiles. Selecting a tile filters the Results list with relevant presets.
Hovering over a tile reveals an arrow icon (>) which when clicked loads the first preset of
the associated product. Browsing with tag filters and text search adjusts the Product filter
accordingly. Refer to Filtering by Library.

6. Audition controls: Adjusts the volume at which presets are auditioned as you select them
in the Results list. Auditioning presets is active by default and can be muted by clicking the
speaker icon.

7. Show/Hide Presets: Displays and hides the Results list. Click Show Presets to display the
Results list, or click Hide Presets to hide it. The number of presets currently displayed in
the Results list is also indicated. This useful feature allows you to monitor the effect of your
filtering, highlighting the potential need for tag refinement to help narrow down extensive
Results lists.

8. Info (I): Shows/hides the Info pane, which displays information relating to the properties and
tags of the selected preset. You can also assign tags to user presets in this pane. The Info
pane is only available when the Results list is displayed. Refer to Info Pane.

9. Results list: Displays the list of presets corresponding to your search criteria. Presets are listed
in alphabetical order and the selected preset is highlighted. Click a preset to audition the sound
without loading the preset. Double-click a preset to load it into the current slot. You can also
use the up/down arrows on your computer keyboard to select the previous/next preset from
the list. Drag the left border of the the Results List to expand or shrink the list area.

10. Bank filter: Contains all banks and sub-banks (if any) of the selected product. Selecting a bank
or a sub-bank filters the Results list accordingly.

11. Close (x icon): Closes the Browser when clicked.

12. Pin (pin icon): Pins the Browser open while you search for presets. By default, Pin is
deactivated and the Browser closes automatically when you load a preset. Clicking the Pin
button activates Browser pinning, allowing you to audition and load presets without closing the
Browser automatically.
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13. Favorites (star icon): Displays only your Favorites in the Results list. You can define any presets
in the Results list as Favorites, creating quick access to a custom collection of your most
beloved presets. Refer to Using Favorites.

14. User Content: Filters by user content. When activated, the Browser only shows user presets.
When deactivated, the Browser only shows factory presets. For more information on user
presets, refer to Presets .

15. Reset: Resets all filters, including the brand, product, bank and sub-bank, as well as the Sound
Type and Character tags. In addition, the User Content and Favorites switches are turned off.
You end up with the full list of factory presets available.

Factory refers to content created by a manufacturer. User refers to content that you or
other users have created.

Selecting a Product Type
The Komplete Kontrol software can load four different types of products: Instruments, Loops,
One-shots and Effects. Depending on the slot selected in the Plug-in chain, you can browse and
load only specific product types:

• In the first Plug-in slot, you can browse and load Instruments, Loops or One-shots.
• In the other Plug-in slots, you can only browse and load Effects.
For the first Plug-in slot, you can choose the type of products that will appear in the Browser by
doing the following:

▶ Click the desired entry from the Product Type selector below the Search field.

→ The Browser shows presets for this particular product type. The filters you might have
previously set in the Browser will be retained if possible (that is, only if they match some
presets also for this product type).

Using Filters
Filters enable you to search for sounds using NKS tags and Library tiles. Tags are used to
characterize and classify presets based on various musical attributes. All KONTAKT Library presets
have been tagged in a meaningful way to encourage your sonic exploration and help you find
results quickly.

Three main Filters can be used to help enhance your browsing — Library tiles, Sound Type tags
and Character tags. Library tiles allow you to search and filter for preset sounds within a specific
Library. Selecting a Library tile will display preset results only available to that product, whilst
highlighting all relevant tags. Sound Type and Character filters use NKS tags to search for preset
sounds. Switch between the two Filters interchangeably by clicking the respective name. Type and
Character tags in addition to the Search field can be used to further refine your search results. Hide
the Sound Type and Character filters by clicking the arrow icon to minimize the section. A Reset
button will appear in the search bar when a filter is applied. Click this to reset all filters.
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Filtering by Sound Type
Sound Type tags are structured into two hierarchical levels, allowing you to search for files based
on applied Type and Subtype tags. The Sound Type filter initially displays top-level tags only, whilst
selecting a tag will display the related NKS Subtype tags below. The hierarchical structure means
that Subtype tags are specific to the respective Sound Type tag. This provides quick access to a
range of presets from different Libraries that share similar sonic functions.

Selecting multiple tags helps you to further refine your search. In the case of multi-selection,
repeating Subtype tags are merged into a single tag. When selecting multiple tags, the last item
added to the selection is also focused.

To filter by Sound Type tags:

1. Click Sound Type in the Filter section on the left pane of the Browser.

2. Click on a Sound Type tag. Any related NKS Subtype tags will be displayed below.

3. Press [shift] + click to select multiple Sound Type tags.
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4. Click on a Subtype tag to filter the preset list to the relevant presets.

→ The presets in the Results list are filtered by the selected Filter tags. Presets carrying any of the
selected Filter tags are displayed.

You can also use [command] (macOS) or [Ctrl] (Windows) + click to select mulptiple
tags.

Filtering by Character
The Character filter provides an additional level that is independent from the Sound Type filter.
These tags are used to further categorize sound characteristics that are common between
different Instruments and Sound Types. This offers an additional flexible level of tagging that
allows you to browse Instruments with similar characteristics to find a range of samples that meet
your identified criteria.

Selecting multiple tags helps you to further refine your search. In the case of multi-selection,
repeating Subtype tags are merged into a single tag. When selecting multiple tags, the last item
added to the selection is also focused.

To filter by Character tags:

1. Click Character in the Filter section on the left pane of the Browser.

2. Click on a Character tag.

3. Press [shift] + click to select multiple Character tags.
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4. As you continue to select Character tags, the Results list will display only relevant presets.

→ The presets in the Results list are filtered by the selected Filter tags. Only presets carrying all of
the selected Filter tags are shown.

You can also use [command](macOS) or [Ctrl](Windows) + click to select multiple
tags.

Filtering by Library
The Library tiles are located below the Sound Type and Character Filters and display all your
available KONTAKT libraries and custom content. Clicking a Library Tile highlights the selected
library and filters the Results list down to its relevant presets. You can further refine your search
using the Sound Type and Character Filters, as well as the Search field.

To filter presets using the Library Tiles:

1. Open the Browser.
2. Select a Library from the Library Tiles. The presets of the selected Library are displayed in the

Results list.
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3. Click the All Banks button to open the Banks menu.

4. Select from the drop-down menu to refine your search. The presets in the Result list will update
accordingly.
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5. Additionally, you can use Sound Type and Character tags to filter your search.

→ The presets in the Result list will update according to the selected Filter tags.

The Browser also enables you to import non-player, legacy and custom content as
Library tiles. For more information, refer to Managing Imported Content.

Using the Search Field
The Search field at the top of the Browser interface allows you to filter presets with text entry. The
search considers preset names, author, Filter titles, and metadata including Character and Product
tags.

To filter presets using the Search field:

1. Activate the Search field by clicking it.

2. Enter your search terms.

→ The Result list is filtered according to the terms entered in the Search field.
 

If you are browsing using Filter tags, your search will only display results according to the selected
tags. Your search entry remains in the field even when the Browser is closed.
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▶ To clear the search, click on the cross icon on the right side of the Search field.

Using Favorites
Favorites enable you to quiclkly find your most frequently used and enjoyed presets, and recall
them at any time. By assigning Favorite tags to presets in the Results list you can create a personal
collection of sounds that can be easily accessed from the Browser. Once assigned, Favorites serve
as an additional filter in the Browser. You can continue to use other filters to refine your search,
including the Search field. Favorites can be used for both factory and user presets.

To assign a Favorite tag:

▶ Click the star icon that appears when a preset is selected or hovered over.

→ The Favorite tag is assigned. Clicking the star again removes the tag.

To view your Favorites in the Result list:
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▶ Click the Favorites icon in the search field.

→ Only presets that have the Favorite tag assigned are shown in the Result list.

Info Pane
The Info Pane displays information relating to the properties and tags of the selected preset. You
can also use the Info Pane to assign tags to user presets.

The Info Pane provides the following information and controls:

1. Properties/Tags: Switches the view between Properties and Tags. Click the name to display
the respective information. For more information about using the Tags view, refer to Managing
User Tags .

2. Product: Displays the name of the product that includes the preset.

3. Bank: Displays the name of the bank that includes the preset.

4. File Extension: Displays the extension of the preset's file format.

5. File Size: Displays the file size of the preset on disk.

6. Brand: Displays the name of the manufacturer that created the library.

7. Author: Displays the name of the author that created the preset.
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8. Comment: Displays the optional comment embedded in the preset.
9. Info Pane (i button): Opens and closes the Info pane.

Managing Imported Content
The Browser enables you to import Custom Libraries and User content, adding your imported
content as Library tiles in the Browser. You can batch import multiple libraries in give them custom
names via the alias field.

To import content:

1. Click the Browser icon in the Main Control Panel to open the Browser.
2. Click the Import Content button at the bottom left of the Browser.
3. Select Custom Libraries or User Presets.
4. Click Add.
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5. Locate the content to import and select Open.

→ The custom content is imported and displayed as a Library tile in the Browser.
To remove custom content from the Browser:

1. Click the Import Content button, at the bottom left of the Browser.
2. Select Custom Libraries or User Presets.
3. Select the content in the dialog and click Remove.

→ The custom content is removed from the Browser.
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Presets
A preset recalls a previously saved sound including all individual parameter settings. Presets offer
a way of exploring and saving variations of any Kontakt Instruments for easy recall. In addition to
the presets included in KONTAKT's extensive Factory Library, you can save, load, and import User
presets. The following sections explain the basic workflows involved in using presets.

Saving a User Preset
You can save user presets for instruments and effects loaded in Komplete Kontrol. User presets
are automatically added to the library and can be loaded using the browser. For more information,
refer to Loading a User Preset.

You can add and edit tags for your user preset in the Info pane. For more information,
refer to Managing User Tags .

To save a new user preset:

1. Select the instrument or effect plug-in slot for which you want to save the user preset.
2. Click Save or Save As... under File in the Main menu.
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3. Enter a name for your new user preset and click Save in the Save Preset dialog.

→ Your user preset is saved and added to the library.
On your hard drive, user preset files are saved in the following folder (in subfolders sorted by
instrument):

• Windows: C:\Users\<your user name>\Documents\Native Instruments\User
Content\

• macOS: Macintosh HD/Users/<your user name>/Documents/Native
Instruments/User Content/

User presets created using NI products are compatible with the respective plug-ins and stand-
alone applications. For example, you can save a user preset using Massive in Komplete Kontrol,
and then load it in the Massive plug-in by opening the file from the user content folder. You can
also add them to the user content section in the Maschine Library by clicking Rescan under User
on the Library page in the Maschine Preferences.

Loading a User Preset
You can load a User preset from its respective Snapshot menu in the Instrument Header. You can
also access all your User presets from one place in the new Browser.

To load a User preset:

1. Open the Browser.
2. Click the User content button to display all your custom presets.

3. Click a User preset from the Results list to preview the sound.
4. Double-click the preset name to load it.

→ The User preset loads in KONTAKT.

Deleting a User Preset
You can delete any of your User presets.

To delete a User preset:

1. Select the desired preset in the Browser.
2. Right-click and select show in Finder / Explorer

BROWSER 20



3. Delete the file from the disk.

→ The file is removed from the Browser on next launch of KONTAKT.

Managing User Tags 
You can view and edit User preset tags using the Browser's Info pane. Sound Type and Character
tags can be assigned and unassigned, allowing you to browse your User presets using filtering and
text search. By holding shift and selecting multiple presets, tags can be edited in bulk.

To assign tags to a User preset:

1. Click the User button to display your User presets.

2. Select a User preset from the Results list.

3. Click the Info pane icon.

4. Select the Tags filter.

5. Select the Sound Type and Character tags that relate to your User preset.
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6. Click Apply.

→ The selected tags are saved to the User preset file.
You can also add your own User Filter tags and assign them to a User preset in the Info Pane of the
Browser.

To add a User Filter tag:

1. Select the User preset you want to assign your own User Filter tag to in the Results list by
clicking on the corresponding entry.

2. Click the Info Pane button in the bottom right corner of the Results list to open the Info pane.
3. Click on the + icon under the Filter type you want to add your User Filter tag to.
4. Type in a name for your User Filter tag.
5. Press [Enter] or click anywhere in the Info pane to confirm the name and save your User Filter

tag.

→ Your new User Filter tag is added and assigned to the User preset.
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6. Using Plug-ins
This sections describes how to use plug-ins in Komplete Kontrol, from instruments to loops,
one-shots, and effects. Plug-ins can be loaded and organized in the Plug-in chain.

The Plug-in chain enables you to load instruments and effect plug-ins. You can change the order,
however only an instrument or a sample can be loaded in to the first Plug-in slot.

The Plug-in chain consists of the following elements:

1. Plug-in chain: Displays the loaded Instruments and effects. The signal flow is from left to right.
2. Plug-in slot: Each Plug-in slot represents a plug-in and displays the product’s name and image.

Clicking on a Plug-in slot selects it. When selected, you can use the Browser to load a new
plug-in into the Plug-in slot by opening a preset.

3. On/off: Activates or deactivates the Plug-in slot and bypasses the loaded plug-in.
4. Replace plug-in: Loads another plug-in and replaces the loaded plug-in.
5. Clear: Removes the loaded plug-in from the respective Plug-in slot.
6. Add plug-in: Loads another plug-in and places it at the end of the Plug-in chain. In the first

Plug-in slot, this button loads an instrument.
7. Plug-in chain button: Opens or closes the Plug-in chain.

Loading Plug-ins
Plug-ins supporting the Native Kontrol Standard (NKS) are automatically loaded when you open a
Preset from the Browser. However, you can also load any plug-in directly and benefit from features
like Play Assist and unified preset management.

To load a plug-in in Komplete Kontrol:

1. Open the Plug-in chain using the button in the Header.
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2. Click the + button to open the context menu and select a plug-in from the list. You can only load
instruments in the first slot, and only effects in the following slots.

→ The plug-in is loaded in its default state.

To replace a plug-in that is already loaded in the Plug-in chain with another plug-in:

▶ Click the arrow button at the bottom of the respective slot in the Plug-in chain and select a
plug-in from the list.

→ The plug-in is loaded in its default state.

Alternatively, you can use the Main menu to load plug-ins. If you load an instrument from the Main
menu, an already loaded instrument will be replaced. If you load an effect from the main menu, it
will be added in a new slot at the end of the Plug-in chain.

▶ Go to the Main menu and select a plug-in from the Instruments or the Effects submenu.

→ The plug-in is loaded in its default state.

If your plug-ins do not show up in the Instruments or the Effects submenu, check if
the plug-in folders on your hard drive are correctly added to the Locations pane on the
Preferences’ Plug-ins page.

Controlling Instrument and Effect Parameters
This section introduces you to controlling instrument, loop and one-shot, and effect parameters.
All NKS instruments are pre-mapped, which means that the controls on your Kontrol keyboard are
automatically assigned to key parameters as soon as you load an instrument in Komplete Kontrol.
The same applies to your third-party keyboard if you have mapped its controls in Komplete Kontrol.
For more information about MIDI learn, refer to Mapping MIDI Controls to Third-Party Controllers.
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Once you have loaded an instrument, the knobs on the keyboard are automatically assigned to
eight instrument parameters. Whenever you turn a knob on the keyboard, the mapped parameter
visually reflects the movement in the Komplete Kontrol software.

Customizing Parameter Mappings using the Plug-in Panel
You can customize the parameter mapping for each preset in the Plug-in panel of the
Komplete Kontrol software by activating Edit mode.

To make your changes permanent, save the preset to the Komplete Kontrol User
Library. For more information, refer to Saving a User Preset.

Activating Edit Mode
▶ To activate or deactivate Edit mode, click on the Edit mode button in the upper right corner of

the Plug-in panel.

Using Edit Mode
Edit mode enables you to add, remove, and rename parameters, pages, or page sections in the
mapping, as well as learn parameters to controls.

1. Each page of the Control section on the Komplete Kontrol keyboard shows up as a label at the
top of the Plug-in panel.
1. Click on a label to view and edit the controls on this page. The current page is highlighted.

2. To delete a page, click on the cross icon next to its label.
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2. The Add Page button allows you to add more pages to the Control section for the current
preset.

3. The Learn button enables Learn mode for the Plug-in panel.
▶ In Learn mode, select a control in the Plug-in panel and move any parameter on the

Instrument’s panel to learn this parameter to the selected control (highlighted in blue).
4. Controls can be grouped to sections to show related parameters in a coherent manner.

1. Double-click on the empty space above a parameter, enter a name, and then press [enter] or
click elsewhere to create a new section starting with the chosen parameter.

2. To rename an existing section, double-click on it and enter a new name. Press [enter] or
click elsewhere to confirm the changes.

5. The name of each control is shown below the corresponding knob in the Plug-in panel.
▶ To change the name of a control, double-click on it and enter a new name. Press [enter] or

click elsewhere to confirm the changes.
6. If you place the mouse over a control in Edit mode, additional options allow for changing the

parameter mapping of this control.
1. Click on the arrow icon at the left of the control’s knob and select a parameter from the

drop-down menu to map it to this control.
2. Click on the cross icon at the right of the control’s knob to delete this control from the

current page.

Using Effects
You can add effects to your instrument in the Plug-in chain. By combining different types of effects
and changing their order it is possible to achieve refined and complex sounds directly in Komplete
Kontrol.

Opening the Plug-in Chain
▶ Click on the Plug-in chain button in the Header.

→ The Plug-in chain and the loaded instrument are displayed. You can now add effects to the
Plug-in chain.

Adding Effects
Once an Instrument, Loop or One-shot has been loaded into the first Plug-in slot, you can then add
Effects to the Plug-in chain. To add an Effect to the Plug-in chain:
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1. Click on the empty Plug-in slot to select it.

→ The Product Type icon in the Browser changes to Effects.

The Product selector provides you with a list of the available Effects.
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2. Browse for an Effect to your liking.

→ The Effect is loaded. Its image (or a generic icon for non-NKS Plug-ins) and name are shown
in the second Plug-in slot. To add more Effects to the Plug-in chain, repeat the aforementioned
steps.

Selecting Plug-in Slots
When you have several Effects added to the Plug-in chain you can directly jump to a Plug-in slot in
order for adjusting the included Effect.

In order to jump to another Plug-in slot and display the Effect’s controls:

▶ Click on the Plug-in slot you want to select.
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Reordering Effects
If you want to reorder your Effects in the Plug-in chain you can easily move them by drag and drop.

In order to move an Effect in the Plug-in chain:

1. Hover the mouse over the Plug-in slot you want to move.

2. Click and hold the left mouse button and move the mouse pointer to the desired position in the
Plug-in chain.

→ The white line between the borders of the Plug-in slots is the current position for dropping the
Plug-in slot.

3. Drop the Effect into a new position in the effects chain.

→ The Plug-in slot now sits at another position in the Plug-in chain and the other Plug-in slots
have moved accordingly.

Scrolling the Plug-in Chain
Theoretically, it is possible to add an unlimited amount of Effects to the Plug-in chain. If the Plug-in
chain exceeds the space on the GUI due to numerous Effects loaded, big scroll arrows appear on
the left and/or on the right border.

Right scroll arrow.

In order to scroll through the Plug-in chain:

▶ Click the scroll arrow for the respective direction.

Bypassing Effects
If you temporarily want to listen to the Instrument without a specific Effect for an A/B comparison
but do not want to delete it from the Plug-in chain, you can bypass Effects.

In order to bypass an Effect:
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1. Hover the mouse over the Plug-in slot containing the Effect you want to bypass.

→ Additional controls are displayed.
2. Click the Bypass button at the top left of the Plug-in slot.

→ The Effect is now bypassed and the image is grayed out.

Removing Effects
In order to remove an Effect from the Plug-in chain:

1. Hover the mouse over the Plug-in slot containing the Effect you want to remove.

→ Additional controls are displayed.
2. Click the Remove button at the top right of the Plug-in slot.

→ The Effect is now removed from the Plug-in chain.

Using Loops and One-Shot Samples
In Komplete Kontrol you can also work with loops and One-shot samples using the Sampler plug-in
or the Audio plug-in. In this section you will learn about the different use cases of the Sampler
plug-in and the Audio plug-in, how you load samples, how you open the Sampler plug-in and the
Audio plug-in, and how to switch between the Sampler plug-in and the Audio plug-in.
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Audio Plug-In
When you load a sample of content type Loop from the Browser, the sample is automatically
loaded into the Audio plug-in so you can play it immediately. The Audio plug-in specializes in
keeping audio loops playing in-sync with the project in your host software and has the optional
ability to do so without influencing the key of the loop. Furthermore, you can transpose the loop
while it plays so that it fits the key of your song. Important parameters can be accessed via the
GUI, but all parameters for the Audio plug-in can be accessed via the Plug-in panel or a connected
keyboard. As for any Instrument or the Sampler plug-in, the Audio plug-in uses the first Plug-in slot
in the Plug-in chain.

For more information on using the Audio plug-in, refer to Using Loops and One-Shot Samples.

The Audio plug-in provides you with the following elements and parameters:

Audio plug-in.

1. Timeline: Shows the timeline of the loop in musical units, including bars and beats.
2. Waveform display: Shows the waveform of the loaded loop. When a sample is played back, a

playhead is shown in the waveform display. With the scroll wheel of your mouse, you can zoom
in and out the waveform display. Right-clicking on the waveform display opens a context menu
for finding the loop on your computer.

3. Start Marker: Determines the start point of the loop by moving it left or right. You can adjust
the Start Marker only from within the software.

4. End Marker: Determines the end point of the loop by moving it left or right. You can adjust the
End Marker only from within the software.

5. Fade: Sets a simple fade-in/fade-out amount to avoid pops or clicks that may occur when
playing loops with the Audio Plug-in.

6. Tune: Transposes the tune of the loop within the range of -36 to +36 semitones. You can use
this control to set the playback pitch of the loop to 'C', and then the loop's pitch will match the
pitch of notes programmed into the host sequencer. This parameter is only available in Stretch
and Formant Engine mode (8).

7. Pitchbend: Sets the Pitchbend range of the loop from -12 to +12 which is relative to the Tune
parameter. This parameter controls the effect of the Pitch Wheel/Slider on your MIDI controller.
This parameter is only available in Stretch and Formant Engine mode (8).
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8. Engine: Here you can choose from three different playback engine modes from the drop-down
menu:
• Re-pitch: This playback engine mode matches the tempo of the loop to the host

sequencer's tempo by changing the playback rate of the loop, and playback rate changes
will result in pitch changes to the loop. Like a vinyl record, playing it faster will also cause
the pitch of the loop to rise, whereas slowing it down causes the overall pitch to drop. This
mode is therefore more suitable for non-pitched material, like drums and percussion, and
has the benefit that the transients of sounds remain sharp and also uses significantly less
CPU than the other Engine modes. Since tempo and pitch are not independently adjustable
with this Engine, any pitch automation you may have done via Events entered will be
ignored, only the rhythm of the Events will be used to gate the Loop on and off.

• Stretch: This playback engine mode provides complete independence between tempo
and pitch. With this engine, you can change the tempo of a loop without changing its
pitch, you can change its pitch without changing its tempo, or you can change both the
tempo and pitch simultaneously. This mode even allows you to automate pitch changes by
entering notes into the host sequencer. As this mode provides complete tempo and pitch
independence, and also works on polyphonic material, it requires more CPU power than
other Engines.

• Formant: This playback engine mode is best suited to pitched (tonal) audio as it preserves
the formant of the sound. By preserving the formant, it retains the intrinsic character and
avoids any shifts in pitch that would normally result in the undesirable cartoon-like effects
on vocals when they are pitched upwards or downwards.

9. Tempo: Sets the original tempo of your loop so that the Audio plug-in can accurately play
it in sync, no matter what tempo you choose in your host sequencer. This is useful if your
host software has miscalculated the tempo while importing the loop. However, be aware that
changing Tempo during playback could affect the synchronization of your loop.

10. Length: Sets the original length of your loop so that the Audio plug-in can accurately play
it in sync, no matter what tempo you choose in your host sequencer. This is useful if your
host software has miscalculated the length while importing the loop. However, be aware that
changing Length during playback could affect the synchronization of your loop.

All parameters of the Audio plug-in can be adjusted by clicking the parameter and dragging
the mouse upwards or downwards. Pressing the [SHIFT] key on your computer keyboard while
dragging sets finer increments.

Sampler Plug-In
When loading a sample from the One-shots tab in the Browser, the sample will be automatically
loaded into the Sampler plug-in so it can be played immediately. Important parameters can be
accessed via the GUI, but all parameters for the Sampler plug-in can be accessed via the Plug-in
Panel or a connected keyboard.

For more information on using the Sampler plug-in, refer to Using Loops and One-Shot Samples.
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Sampler plug-in.

1. Waveform display: Shows the waveform of the Sample.
2. Start: Determines the Start point of the sample. When Loop is active, the Loop Point

determines the start of the loop.
3. PITCH: Defines the pitch of your sample and adjusts the pitch within three octaves up or down.

As this is a traditional sampler.
4. ENVELOPE: Selects one of three envelope types (One-shot, AHD and ADSR). For more

information, refer to Envelopes.
5. Loop Point: Sets the point at which the loop will start playing. The Loop Point can be set

independently of the Start Point.
6. LOOP: When the ON button is activated, the sample will loop at a length determined by the

Loop Point and End Point.
7. X FADE: Determines the type of fade between the loop points.
8. End Point: Sets the End point of the sample. When Loop is active, the End Point determines the

length of the loop.
9. Timeline: Shows the time scale in seconds.

Envelopes
An envelope allows you to modify the shape and timing of your sample, so you can create more
expressive and dynamic sounds. There are three Envelope types available in the Sampler plug-in;
One Shot, AHD and ADSR. Each Envelope will affect the playback and behavior of the sample.

One-shot
One-shot operates like a typical vintage drum machine; the sample is played in its entirety from
beginning to end, with no envelope. When this type is selected, no parameters are displayed.

The One-shot Envelope.
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AHD
AHD disables the Sustain and Release controls of the ADSR envelope and replaces them with the
Hold parameter. AHD mode is ideal for triggering a sample for a certain amount of time, regardless
of how long the pad is held.

The AHD Envelope.

• ATTACK: Attack determines how quickly the sample reaches full volume after being triggered.

• HOLD: Hold determines how long the envelope will stay at its maximum level.

• DECAY: Decay is used to adjust how fast the sample takes to fade to out.

ADSR
The ADSR Envelope is generally used for longer, sustained samples that require complex dynamic
control.

The ADSR Envelope.

• ATTACK: Attack determines how quickly the sample reaches full volume after being triggered.

• DECAY: Decay determines how fast the envelope drops to the Sustain level.

• SUSTAIN: Sustain determines the constant level being kept after Decay until the note ends.

• RELEASE: Release determines how long the sound takes to fade out after the note has ended.

Sampler Plug-In and Audio Plug-In Use Cases
The Sampler plug-in and the Audio plug-in have different use cases and provide different
parameters for adjustments:

• With the Sampler plug-in you can define the start point and end point of the loaded sample, and
modify the shape and timing. For more information on the parameters of the Sampler plug-in,
refer to Sampler Plug-In.

• The Audio plug-in specializes in keeping audio loops playing in-sync with the sequencer in your
host software and has the optional ability to do so without influencing the key of the loop.
Furthermore, you can transpose the loop while it plays so that it fits the key of your song. For
more information on the parameters of the Audio plug-in, refer to Audio Plug-In.

Loading One-Shot Samples and Loops
When you load a sample of the content type One-shot from the Browser, the sample will be
automatically loaded into the Sampler plug-in. When you load a sample of the content type Loop
from the Browser, the sample will be automatically loaded into the Audio plug-in. However, once the
Sampler plug-in or the Audio plug-in is opened, you can still load loops and One-shot samples into
either of them.

To load a loop or One-shot sample from the Browser:
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1. Select the first Plug-in slot in the Plug-in chain.
2. Select the content type Loop or One-shot sample in the Browser.
3. Refine your search using TYPES and CHARACTER tags.
4. Drag the loop or One-shot sample from the Results list into the Plug-in area.

→ The loop or One-shot sample is loaded into the corresponding plug-in. You can now play and
edit it using the parameters.

When the Audio plug-in is opened, loops and samples from the Browser will be loaded
into the Audio plug-in. When the Sampler plug-in is opened, loops and samples from
the Browser will be loaded into the Sampler plug-in.

It is not possible to manually save Presets for the Audio plug-in. The Save and Save
As… entries in the Komplete Kontrol menu are grayed out when the Audio plug-in is
opened.

Opening the Audio Plug-In or Sampler Plug-In
You can open an empty Audio plug-in or Sampler plug-in using the Komplete Kontrol menu in the
header. This enables you to load samples of each content type into the Audio plug-in or Sampler
plug-in.

To open the Audio plug-in or Sampler empty:

1. Open the Komplete Kontrol menu in the header.
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2. Select Instruments > Internal > Audio to open the Audio-plug-in, or select Instruments > Internal
> Sampler to open the Sampler plug-in.

→ The Audio plug-in or Sampler plug-in has opened. It uses the first Plug-in slot in the Plug-in
chain. You can now load loops or One-shot samples from the Browser via drag and drop.

Switching between the Audio Plug-In and the Sampler Plug-In
When you intend to use the loaded loop in the Audio plug-in with the Sampler plug-in instead, you
can switch from Audio plug-in to Sampler plug-in. Switching from Audio plug-in to Sampler plug-in
retains the loaded loop and vice versa.

To switch from the Audio plug-in to the Sampler plug-in or vice versa:

1. Select the first Plug-in slot in the Plug-in chain.
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2. Open the Komplete Kontrol menu in the header and select Instruments > Internal > Sampler, or
Instruments > Internal > Audio.

→ The Audio plug-in has switched to Sampler plug-in. The loop retains loaded.

Playback Behavior of Audio Plug-In in Host Software
When you start playback in your host software, the loop will be triggered and play continuously.
However, the loop will only be audible in locations where you placed notes in the host sequencer.
Furthermore, when you use the playback engine mode Stretch, the pitch of the loop will be
transposed based on the pitch of the note used. For example, note C3 will play the sample at its
original pitch, while C4 will play the sample at one octave higher.

You can also play loops with the keyboard in your host software:

• When the transport is not running, you can trigger the loop by pressing a key.
• When the transport is running and you press a key, a gate will open at the positions where

notes are placed in the host sequencer.
For more information on playback engine mode, refer to Audio Plug-In.
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7. Using Scales and the Arpeggiator
With Play Assist, Komplete Kontrol gives you new and inspiring ways to perform using the Scale
engine and the Arpeggiator. Map your keyboard to any one of over 100 different scales and modes,
play chords with one finger, effortlessly create expressive arpeggios, and more.

The Perform panel lets you access all the parameters related to the Scale engine and the
Arpeggiator.

1. SCALE: Clicking the round button left of SCALE switches the Scale engine on or off. Clicking
the SCALE label displays the Scale engine’s parameters. See Scales for details.

2. ARP: Clicking the round button left of ARP switches the Arpeggiator on or off. Clicking the ARP
label displays the Arpeggiator’s parameters. See Arpeggiator for details.

3. Parameter pages: If multiple pages of parameters are available, you can switch between them
here.

Scales
The Scale engine maps the notes you play using your keyboard or sequencer to the closest notes
contained in the selected scale. It features a vast amount of different scales that you can use
to play your instruments. In Chord mode, you can use the scales to generate chords from single
notes. Combined with the Arpeggiator, you can play scales automatically with a variety of different
motives and rhythms.

Activating the Scale Engine in the Software
To activate the Scale engine:

1. Click the Perform panel button in the Header to show the Perform panel.
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2. Click the check box next to SCALE in the Perform section.

→ The Scale engine is activated and ready to be used.

Editing Scales and Chords
You can tailor the scales and chords to your needs using the Scale engine parameters.

• You can select the scale to be mapped to the keys of the keyboard and set its root note by
using the SCALE parameters Root Note, Bank, and Type. For more information, refer to Scale
Parameters.

• You can define how the selected scale is mapped to the keys of the keyboard by using the
KEY MODE parameter Mode. For more information, refer to Key Mode Parameter.

• You can automatically generate custom chords while playing on the keyboard by using
the CHORD parameters Mode, Type, and Position. For more information, refer to Chord
Parameters.

▶ To edit the Scale engine parameters in the Komplete Kontrol software, click on SCALE in the
Perform panel so it is highlighted.

Scale Parameters
The SCALE parameters Root Note, Bank, and Type allow you to select the scale to be mapped to
the keys of the keyboard and set its root note.

Scale Root Note
The first SCALE parameter is Root Note. Setting the root note of a scale means deciding what key
the scale will begin with. The following notes of the scale depend on which scale pattern you select
with the SCALE Type parameter (see below). You can transpose any scale pattern up or down by
selecting a different Root Note.

The Root Note setting includes the following values:

• C, C#, D, D#, E, F, F#, G, G#, A, A#, B
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Scale Bank and Type
The second and third SCALE parameters from the left are Bank and Type. Use them to decide the
scale pattern according to which the notes will be mapped onto the keys of the keyboard. Each
Bank consists of 15 thematically related scales, which can be selected by using the Type control.

For example, using the default Root Note value C combined with the default Type Major from
the default Bank Main, you get the scale C major, which spans over one octave and contains the
notes C, D, E, F, G, A, and B (followed by C again). If instead you select G as your Root Note, the
G major scale contains the notes G, A, B, C, D, E, and F♯ (followed by G again). You will notice that
the distance between each note follows the same pattern of “whole step–whole step–half step–
whole step–whole step–whole step–half step,” which is the pattern of the Major scale.

If you are triggering an Instrument via an incoming MIDI pattern from the DAW, the notes of the
MIDI pattern will be mapped onto the closest keys belonging to the selected Type. This means
that, for example (with Root Note set to C) a MIDI pattern consisting of the notes C-D-D♯ will be
played back as such if Type is set to Chromatic from Bank Main, but instead as C-D-E if Type is
set to Major.

The actual keys triggering the scale notes, as well as the behavior of inactive keys
(unlit LEDs) depend on the KEY MODE Mode parameter (Knob 4).

The following scales are available:

Main Scales

Scale Bank Type Degrees
Chromatic Main Chrom 1 ♭2 2 ♭3 3 4 ♭5 5 ♭6 6 ♭7 7

Major Main Major 1 2 3 4 5 6 7

Minor Main Minor 1 2 ♭3 4 5 ♭6 ♭7
Harm Min Main Harm Min 1 2 ♭3 4 5 ♭6 7

Maj Pent Main Maj Pent 1 2 3 5 6

Min Pent Main Min Pent 1 ♭3 4 5 ♭7
Blues Main Blues 1 ♭3 4 ♯4 5 ♭7
Japanese Main Japanese 1 2 ♭3 5 ♭6
Freygish Main Freygish 1 ♭2 3 4 5 ♭6 ♭7
Hungarian Min Main Hung Min 1 2 ♭3 ♯4 5 ♭6 7

Arabic Main Arabic 1 ♭2 3 4 5 ♭6 7

Altered Main Altered 1 ♭2 ♯2 3 ♯4 ♭6 ♭7
Whole Tone Main WH Tone 1 2 3 ♯4 ♯5 ♭7
H-W Dim Main H-W Dim 1 ♭2 ♯2 3 ♯4 5 6 ♭7
W-H Dim Main W-H Dim 1 2 ♭3 4 ♯4 ♯5 6 7

Modes Scales

Scale Bank Type Degrees
Ionian Modes Ionian 1 2 3 4 5 6 7
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Scale Bank Type Degrees
Dorian Modes Dorian 1 2 ♭3 4 5 6 ♭7
Phrygian Modes Phrygian 1 ♭2 ♭3 4 5 ♭6 ♭7
Lydian Modes Lydian 1 2 3 ♯4 5 6 7

Mixolydian Modes Mixolyd 1 2 3 4 5 6 ♭7
Aeolian Modes Aeolian 1 2 ♭3 4 5 ♭6 ♭7
Locrian Modes Locrian 1 ♭2 ♭3 4 ♭5 ♭6 ♭7
Ionian b2 Modes Ion b2 1 ♭2 3 4 5 6 7

Dorian b5 Modes Dor b5 1 2 ♭3 4 ♭5 6 ♭7
Harm Phryg Modes Har Phry 1 ♭2 ♭3 4 5 ♭6 7

Phryg Major Modes Phry Maj 1 ♭2 ♭3 4 5 6 7

Lydian b3 Modes Lyd b3 1 2 ♭3 ♯4 5 6 7

Major Locrian Modes Maj Loc 1 2 3 4 ♭5 ♭6 ♭7
Minor Locrian Modes Min Loc 1 2 ♭3 4 ♭5 ♭6 ♭7
Super Locrian Modes Sup Loc 1 ♭2 ♭3 ♭4 ♭5 ♭6 ♭7

Jazz Scales

Scale Bank Type Degrees
Lydian ♭7 Jazz Lyd ♭7 1 2 3 ♯4 5 6 ♭7
Altered Jazz Altered 1 ♭2 ♯2 3 ♯4 ♭6 ♭7
Diminished Jazz Diminshd 1 ♭2 ♯2 3 ♯4 5 6 ♭7
Mixo b13 Jazz Mix b13 1 2 3 4 5 ♭6 ♭7
Mixo b9 b13 Jazz Mixb9b13 1 ♭2 3 4 5 ♭6 ♭7
Lydian ♭7 b2 Jazz Lyd ♭7b2 1 ♭2 3 ♯4 5 6 ♭7
Bebop Jazz Bebop 1 2 3 4 5 6 ♭7 7

Whole Tone Jazz Whole Tn 1 2 3 ♯4 ♯5 ♭7
Blues Maj Jazz Blues Ma 1 2 ♭3 3 5 6

Blues Min Jazz Blues Mi 1 ♭3 4 ♯4 5 ♭7
Blues Combined Jazz BluesCmb 1 2 ♭3 3 4 ♯4 5 6 ♭7
Lydian #5 Jazz Lyd #5 1 2 3 ♯4 ♯5 6 7

Jazz Minor Jazz Jazz Mi 1 2 ♭3 4 5 6 7

Half Dim Jazz Half Dim 1 2 ♭3 4 ♭5 ♭6 ♭7
Augmented Jazz Augmentd 1 ♭3 3 5 ♯5 7

World Scales

Scale Bank Type Degrees
Hungarian Min World Hung Min 1 2 ♭3 ♯4 5 ♭6 7

Hungarian Maj World Hung Maj 1 ♯2 3 ♯4 5 6 ♭7
Neapolitan World Neapoltn 1 ♭2 ♭3 4 5 ♭6 7
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Scale Bank Type Degrees
Spanish World Spanish 1 ♭2 ♭3 3 4 5 ♭6 ♭7
Greek World Greek 1 2 ♭3 ♭4 5 ♭6 ♭7
Jewish 1 World Jewish 1 1 ♭2 3 4 5 ♭6 ♭7
Jewish 2 World Jewish 2 1 2 ♭3 ♯4 5 6 ♭7
Indian 1 World Indian 1 1 ♭2 ♭3 ♯4 5 ♭6 7

Indian 2 World Indian 2 1 2 ♭3 ♯4 5 6 7

Indian 3 World Indian 3 1 ♭2 2 4 5 ♭6 6

Indian 4 World Indian 4 1 ♯2 3 4 5 ♯6 7

Mid East 1 World M East 1 1 ♭2 3 4 5 ♭6 7

Mid East 2 World M East 2 1 ♭2 3 4 ♭5 ♭6 7

Mid East 3 World M East 3 1 ♭2 ♭3 4 ♭5 6 ♭7
Mid East 4 World M East 4 1 ♭2 3 4 ♭5 6 ♭7

5-Tone Scales

Scale Bank Type Degrees
Penta I 5-Tone Pent I 1 2 3 5 6

Penta II 5-Tone Pent II 1 2 4 5 ♭7
Penta III 5-Tone Pent III 1 ♭3 4 ♭6 ♭7
Penta IV 5-Tone Pent IV 1 2 4 5 6

Penta V 5-Tone Pent V 1 ♭3 4 5 ♭7
Hirajoshi 5-Tone Hira 1 2 ♭3 5 ♭6
Insen 5-Tone Insen 1 ♭2 4 5 ♭7
Kokin Joshi 5-Tone Kokin 1 2 4 5 ♭6
Akebono 5-Tone Akebono 1 2 ♭3 5 6

Ryukuan 5-Tone Ryukuan 1 3 4 5 7

Abhogi 5-Tone Abhogi 1 2 ♭3 4 6

Bhupkali 5-Tone Bhupkali 1 2 3 5 ♭6
Hindolam 5-Tone Hindolam 1 ♭3 4 ♭6 ♭7
Bhupalam 5-Tone Bhupalam 1 ♭2 ♭3 5 ♭6
Amritavarshini 5-Tone Amrita 1 3 ♯4 5 7

Modern Scales

Scale Bank Type Degrees
Octatonic Modern Octatonc 1 2 ♭3 4 ♯4 ♯5 6 7

Acoustic Modern Acoustic 1 2 3 ♯4 5 6 ♭7
Augmented Modern Augmentd 1 ♭3 3 5 ♯5 7

Tritone Modern Tritone 1 ♭2 3 ♭5 5 ♭7
Leading Wh Tone Modern Lead Wh 1 2 3 ♯4 ♯5 ♯6 7
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Scale Bank Type Degrees
Enigmatic Modern Enigmatc 1 ♭2 3 ♯4 ♯5 ♯6 7

Scriabin Modern Scriabin 1 2 3 ♯4 6 ♭7
Tcherepnin Modern Tcherepn 1 ♯1 ♯2 3 4 5 ♯5 6 7

Messiaen I Modern Mes I 1 2 3 ♯4 ♯5 #6

Messiaen II Modern Mes II 1 ♭2 ♯2 3 ♯4 5 6 ♭7
Messiaen III Modern Mes III 1 2 ♭3 3 ♯4 5 ♭6 ♭7 7

Messiaen IV Modern Mes IV 1 ♭2 2 4 ♯4 5 ♭6 7

Messiaen V Modern Mes V 1 ♭2 4 ♯4 5 7

Messiaen VI Modern Mes VI 1 2 3 4 ♯4 ♯5 ♯6 7

Messiaen VII Modern Mes VII 1 ♭2 2 ♭3 4 ♯4 5 ♭6 6 7

Major Scales

Scale Bank Type Degrees
Natural Major Natural 1 2 3 4 5 6 7

Lydian Major Lydian 1 2 3 ♯4 5 6 7

Mixolydian Major Mixolyd 1 2 3 4 5 6 ♭7
Major Minor Major Maj Min 1 2 3 4 5 ♭6 ♭7
Harmonic Major Major Har Maj 1 2 3 4 5 ♭6 7

Dbl Har Major Major Dbl Maj 1 ♭2 3 4 5 ♭6 7

Neapolitan Maj Major Nea Maj 1 ♭2 3 4 5 6 7

Major Locrian Major Maj Loc 1 2 3 4 ♭5 ♭6 ♭7
Blues Major Major Blues Ma 1 2 ♭3 3 5 6

Bebop Major Major Bebop Ma 1 2 3 4 5 ♯5 6 7

Hexa 1 Major Hexa 1 1 2 3 5 6 7

Hexa 2 Major Hexa 2 1 2 3 4 5 6

Penta 1 Major Penta 1 1 2 3 5 6

Penta 2 Major Penta 2 1 3 4 5 7

Penta 3 Major Penta 3 1 3 5 6 7

Minor Scales

Scale Bank Type Degrees
Natural Minor Natural 1 2 ♭3 4 5 ♭6 ♭7
Dorian Minor Dorian 1 2 ♭3 4 5 6 ♭7
Phrygian Minor Phrygian 1 ♭2 ♭3 4 5 ♭6 ♭7
Minor Major Minor Min Maj 1 2 ♭3 4 5 6 7

Harmonic Minor Minor Har Min 1 2 ♭3 4 5 ♭6 7

Dbl Har Minor Minor Dbl Min 1 2 ♭3 ♯4 5 ♭6 7

Neapolitan Min Minor Nea Min 1 ♭2 ♭3 4 5 ♭6 7
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Scale Bank Type Degrees
Minor Locrian Minor Min Loc 1 2 ♭3 4 ♭5 ♭6 ♭7
Blues Min Minor Blues Mi 1 ♭3 4 ♯4 5 ♭7
Bebop Minor Minor Bebop Mi 1 2 ♭3 4 5 ♭6 ♭7 7

Hexa 1 Minor Hexa 1 1 2 ♭3 5 ♭6 ♭7
Hexa 2 Minor Hexa 2 1 2 ♭3 4 5 ♭6
Penta 1 Minor Penta 1 1 2 ♭3 5 ♭6
Penta 2 Minor Penta 2 1 ♭3 4 5 ♭7
Penta 3 Minor Penta 3 1 ♭3 5 ♭6 ♭7

Key Mode Parameter
The KEY MODE Mode menu consists of the following three modes, which are described in detail
below:

• Guide

• Mapped (default value)

• Easy

Easy Mode
In Easy mode, the notes of the selected scale are mapped to the keyboard so that any scale can
be played using the white keys of the keyboard only. The black keys are inactive and pressing them
will not trigger any other notes.

Selecting the 12-step chromatic scale in KEY MODE Easy maps the keys in the same
way as in the Mapped mode.

The Root Note is always mapped to the middle C key (commonly called C3). If the selected scale
consists of seven notes, it matches the seven white keys of a single octave on the keyboard. In
this case, the Root Note coincides with the key C across all octaves of the keyboard. If instead
the selected scale consists of more or less than seven notes, it does not match the seven white
keys of a single octave on the keyboard and the Root Note is shifted throughout adjacent octaves
accordingly.

For two examples of the Easy mode mappings in Major and Minor, refer to below.

Scale Type Key Mappings in Easy Mode
White keys: C3 D3 E3 F3 G3 A3 B3

Major

Corresponding mappings: 1 2 3 4 5 6 7

Example with root note C: C D E F G A B

Minor

Corresponding mappings: 1 2 ♭3 4 5 ♭6 ♭7
Example with root note C: C D ♭E F G ♭A ♭B
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Chord Parameters
The CHORD parameters Mode, Type and Position allow you to define the chord to be played using
the Chord function.

Chord Mode
The first CHORD parameter is Mode. Use it to generate chords from single notes, either from the
keyboard or from incoming MIDI notes from the DAW.

The CHORD parameter Mode.

CHORD Mode has one inactive (Off) and two active states, which are described in detail below:

• Off

• Harmonizer

• Chord Set

Harmonizer
If CHORD Mode is set to Harm (Harmonizer), the CHORD Type menu allows you to specify the
interval of notes in the selected SCALE Type that will constitute the chord: For example, a triad in
the form of the root note, the third note, and the fifth note (CHORD Type value 1-3-5).

The CHORD parameter Mode, set value Harm.

Chord Set
If CHORD Mode is set to Chord Set (Chord Set), the CHORD Type menu allows you to choose from
a selection of major and minor chords depending on the current Root Note.

The CHORD parameter Mode, set value Chd Set.
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The SCALE Type and KEY MODE Mode parameters are not available when CHORD
Mode is set to Chord Set.

Chord Type
The second CHORD parameter is Type. Use it to select the chord that will be generated from a
single note used as input.

The CHORD parameter Type.

The available CHORD Type values depend on whether CHORD Mode is set to Harmonizer or
Chord Set, as described in detail below.

CHORD Type, CHORD Mode Set to Harmonizer

The CHORD parameter Type, set value 1-3-5 (Mode set to Harm).

If CHORD Mode is set to Harmonizer, then CHORD Type will offer you a selection of individual
notes present in the selected SCALE Type. This means that for all scales except the 12-tone
Chrom scale (chromatic scale, refer to further below), you can select the interval of notes that will
make up your chord.

When CHORD Mode is set to Harm, the CHORD Type setting includes the following values:

Chord Type Interval Added to Played Note
Octave Octave

1-3 3rd

1-5 5th

1-3-5 3rd and 5th

1-4-5 4th and 5th

1-3-5-7 3rd, 5th and 7th

1-4-7 4th and 7th
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CHORD Type, CHORD Mode Set to Chd Set

The CHORD parameter Type, set value Maj 1 (Mode set to Chd Set).

If CHORD Mode is set to Chord Set and, for example, the Root Note is set to C, then the CHORD
Type menu presents you with a list of selectable chords. Values are, e.g., Maj 4 and Min 7, which
would generate a major and minor chord, respectively, both using C as the chord’s root note.

When CHORD Mode is set to Chord Set, the CHORD Type setting includes the following values:

• Maj  1, Maj 2, Maj 3, Maj 4, Maj 5, Maj 6, Maj 7, Maj 8, Min 1, Min 2, Min 3, Min 4, Min 5, Min 6,
Min 7, Min 8

CHORD Type and the Chromatic Scale
The Chrom (chromatic) scale consists of every semitone in an octave. This means that when you
play every white key and every black key of an octave up or down, you are playing the 12-step
chromatic scale. Since all semitones of an octave are present in the scale, you can use all keys
to form chords. In turn, selecting Chrom as SCALE Type means that you can select virtually any
CHORD Type. The following chords are available and can be generated:

Chord Type Semitones Added above Played Note
Octave 12

Perf 4 (Perfect 4) 5

Perf 5 (Perfect 5) 7

Major 4 and 7

Minor 3 and 7

Sus 4 (Suspended 4) 5 and 7

Maj 7 (Major 7) 4, 7 and 11

Min 7 (Minor 7) 3, 7 and 10

Dom 7 (Dominant 7) 4, 7 and 10

Dom 9 (Dominant 9) 4, 7, 10 and 14

Min 7 ♭5 (Minor 7 ♭5) 3, 6 and 10

Dim 7 (Diminished 7) 3, 6 and 9

Aug (Augumented) 4 and 8

Quartal 5, 10 and 15

Trichord 5 and 11

ChordPosition
The third CHORD parameter is Position. Use it to spread the notes of a chord generated from a
single note and to aid a more musical transition between chords.
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The CHORD parameter Position.

The Position parameter is available when CHORD Type is set to Harmonizer or Chord Set and
includes the following values:

Position Description
Root The root position of the selected chord is always played.

-1 to -8 Decreasing Position with negative values moves the highest note of the current
chord down by an octave, this inverts the chord to a lower position in the selected
scale.

+1 to +8 Increasing Position with positive values moves the lowest note of the current
chord up by an octave, this inverts the chord to a higher position in the selected
scale.

Auto This provides a more human feel in the transition from one chord to another. The
notes used to form each chord are automatically selected to provide the best
inversion.

Arpeggiator
The Arpeggiator enables you to automatically generate musical sequences according to the notes
you play using your keyboard or sequencer. It features a vast amount of different motives and
rhythms that you can use to play your instruments. Combined with the Scale engine, you can play
motives and rhythms while also constraining the notes to the selected scale.

Activating the Arpeggiator in the Komplete Kontrol Software
To activate the Arpeggiator:

1. Click the Perform panel button in the Header to show the Perform panel.

2. Click the blue check box next to ARP in the Perform panel.

→ The Arpeggiator is activated and ready to be played.
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Playing the Arpeggiator

Editing the Arpeggiator
The Arpeggiator parameters give you many possibilities to shape your own note sequences.

• You can switch between Arp and Note Repeat mode and change the playback direction of the
arpeggiator sequence by using the MAIN parameters Mode and Type. For more information,
refer to Main Parameters.

• You can create interesting rhythms for the arpeggiator sequence by using the RHYTHM
parameters Rate, Sequence, and Swing. For more information, refer to Rhythm Parameters.

• You can change the range of available notes for the arpeggiator sequence, as well as their
velocity and length, by using the OTHER parameters Octaves, Dynamic, and Gate. For more
information, refer to Other Parameters.

• You can explore alternative versions of the same arpeggiator sequence by using the
ADVANCED parameters Retrigger, Repeat, Offset, and Inversion. For more information, refer to
Advanced Parameters.

• You can change the range of keys that trigger the arpeggiator sequence by using the RANGE
parameters Min. Key and Max. Key. For more information, refer to Range Parameters.

• You can latch the playback of the arpeggiator sequence by using the HOLD On/Off parameter.
For more information, refer to Hold Parameter.

Main Parameters
The MAIN parameters Mode and Type allow you to switch between Arp and Note Repeat mode
and change the playback direction of the arpeggiator sequence.

Main Mode
The first MAIN parameter is Mode. lt lets you select either Arp or Note Repeat. Depending on your
selection, a different set of Arpeggiator parameters will be available for further editing.

The Mode setting consists of the following two modes:

• Arp mode, which generates arpeggiator sequences based on chords you play on the keyboard,
or the output of the Scale engine. With the Arpeggiator switched on and Mode set to Arp, any
chord you created using the Scale engine will play as an arpeggiated note sequence. In this
case, you only need to press one key on the keyboard to hear the arpeggiated notes play out
according to the selected scale.

• Note Repeat mode, which deactivates the Arpeggiator and instead repeats whichever note
is input until Komplete Kontrol receives a MIDI note-off message. Use the parameters Rate,
Swing, and Gate to change the rhythm of the repeats.

Main Type
The second MAIN parameter, Type, is only available in Arp mode. It sets the sequential order of
the arpeggiated notes. Choose whether your arpeggiated chord should be played from the root
note and up, the other way around, or even simultaneously. Selecting Order Played will play back
the notes in the order you pressed down the corresponding keys on the keyboard. Automating the
Type parameter in the DAW can create interesting variations and textures.

The Type setting includes the following values:
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• Up, Down, Up & Down, Order Played, Chord

Rhythm Parameters
The RHYTHM parameters Rate, Sequence, and Swing allow you to create interesting rhythms for
the arpeggiator sequence.

Rhythm Rate
The first RHYTHM parameter, Rate, is available in both Arp and Note Repeat mode. It sets the
beat of the Arpeggiator in relation to global tempo in musical values, ranging from 1/1 to 1/128. All
note values (except 1/1 and 1/128) are available as basic notes, dotted notes, and triplets. Dotted
notes are 1.5 times longer than the corresponding basic notes. Triplets are 2/3 the duration of
their corresponding basic notes, so that e.g., three 1/4 notes are equal in duration to two basic 1/4
notes.

The Rate setting includes the following values:

• 1/1
• 1/2 Dotted (1/2 D)
• 1/1 Triplet (1/1 T)
• 1/2
• 1/4 Dotted (1/4 D)
• 1/2 Triplet (1/2 T)
• 1/4
• 1/8 Dotted (1/8 D)
• 1/4 Triplet (1/4 T)
• 1/8
• 1/16 Dotted (1/16 D)
• 1/8 Triplet (1/8 T)
• 1/16
• 1/32 Dotted (1/32 D)
• 1/16 Triplet (1/16 T)
• 1/32
• 1/64 Dotted (1/64 D)
• 1/32 Triplet (1/32 T)
• 1/64
• 1/128 Dotted (1/128 D)
• 1/64 Triplet (1/64 T)
• 1/128
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Rhythm Sequence
The second RHYTHM parameter, Sequence, is only available in Arp mode. It gives you a way of
adding interesting rhythms to your arpeggiated notes. Select one of eight different sequences and
apply it to the arpeggiator sequence you are playing. Combine Sequence with the Rate parameter
to create a huge variety of rhythms at different tempos. If Rate is set to a basic or dotted value,
then Sequence applies a 16-step sequencer to the notes. If Rate is instead set to a triplet value,
then Sequence applies a 12-step sequencer to the notes.

You can switch sequences in real time during playback. For example, if sequence 1 is running and
you instead select sequence 2 after the fourth MIDI note in a pattern has been played back, then
sequence 2 starts when the fifth MIDI note in the pattern is played back.

The Sequence setting includes the following values:

• Off, 1, 2, 3, 4, 5, 6, 7, 8

Rhythm Swing
The third RHYTHM parameter, Swing, is available in both Arp and Note Repeat mode. Adding
Swing to your note sequence can make it feel less quantized and sound more natural. Swing
works by introducing a delay to every second note in a sequence. Doing so often adds a certain
groove to the music.

Swing lets you set a value between 0% and 100%:

1. Set a value of 0% to play the note sequence without swing.
2. Increase the Swing value to add swing by delaying every second note. The delay length is a

percentage of the current step size.
Using Swing in combination with the Gate parameter adds further variations in note duration. For
example, if Gate is set to 100%, Komplete Kontrol sends a MIDI note-off message before each note
and plays back the sequence legato. If Gate is set to values larger or smaller than 100%, then notes
will be scaled after the value of the Swing parameter has been applied, leaving the groove intact.

Other Parameters
The OTHER parameters Octaves, Dynamic, and Gate allow you to change the range of available
notes for the arpeggiator sequence, as well as their velocity and length.

Other Octaves
The first OTHER parameter, Octaves, is only available in Arp mode. It lets you decide the range
of the arpeggiator sequence. You can choose to play back your sequence within the octave of
only the keys you pressed on the keyboard, or you can select up to eight octaves and let the
corresponding notes of your chord or scale be played back in as many octaves.

Depending on the settings you have made to the Type parameter, the octaves played back can be
above (e.g., Up), below (e.g., Down) or both above and below (Up & Down) the pressed keys.

The Octaves setting includes the following values:

• 1, 2, 3, 4, 5, 6, 7, 8
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Other Dynamic
The second OTHER parameter, Dynamic, is only available in Arp mode. It reads the velocity of the
input (a key you pressed on the keyboard or an incoming MIDI note from the DAW) and scales it
by the factor you set with the Dynamic parameter. The scaling is applied per note. The velocity of
each played note is taken and multiplied by the value set with the Dynamic parameter.

Dynamic lets you set a value between 1.0% and 200.0%.

Other Gate
The third OTHER parameter, Gate, is available in both Arp and Note Repeat mode. It lets you
decide the length of the notes in your sequence. Setting a value between 1% and 99% makes the
duration of the notes shorter than they otherwise would be. Setting a value between 101% and
200% instead elongates the duration of the notes.

Gate lets you set a value between 1.0 % and 200.0 %.

Advanced Parameters
The ADVANCED parameters Retrigger, Repeat, Offset, and Inversion allow you to explore
alternative versions of the same arpeggiator sequence.

Advanced Retrigger
The first ADVANCED parameter, Retrigger, is only available in Arp mode. Retrigger sets a number
of steps in the arpeggiator sequence after which the sequence restarts its cycle, regardless of the
number of pitches in the sequence.

For example:

• If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Retrigger is set to 3,
the Arpeggiator output is 1 - 2 - 3 - repeat.

• If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Retrigger is set to 8,
the Arpeggiator output is 1 - 2 - 3 - 4 - 5 - 1 - 2 - 3 - repeat.

Rests in a Sequence are treated as steps:

• If the arpeggiator sequence consists of 6 pitches, the Sequence is 1 - 2 - 3 - rest - 4 - 5 - 6 –
rest, and Retrigger is set to 5, the Arpeggiator output is 1 - 2 - 3 - rest - 4 -repeat.

Advanced Repeat
The second ADVANCED parameter, Repeat, is only available in Arp mode. Repeat sets a number
by which each step in the arpeggiator sequence is repeated.

For example:

• If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3) and Repeat is set to 3, the
Arpeggiator output is 1 - 1 - 1 - 2 - 2 - 2 - 3 - 3 - 3 - repeat.

Advanced Offset
The third ADVANCED parameter, Offset, is only available in Arp mode. Offset sets a number by
which the steps in the arpeggiator sequence are shifted in the cycle.

For example:

• If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to 0, the
Arpeggiator output is 1 - 2 - 3 - 4 - 5 - repeat.
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• If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to +1,
the Arpeggiator output is 2 - 3 - 4 - 5 - 1 - repeat.

• If the arpeggiator sequence consists of a 5 note cycle (1 - 2 - 3 - 4 - 5) and Offset is set to -1,
the Arpeggiator output is 5 - 1 - 2 - 3 - 4 - repeat.

Advanced Inversion
The fourth ADVANCED parameter, Inversion, is only available in Arp mode. Inversion adds inverted
alternations of the arpeggiator sequence to the cycle.

For example:

• If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 0, the Arpeggiator output is 1 - 2 - 3 - repeat.

• If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 1, the Arpeggiator output is 1 - 2 - 3 - 2 - 3 - repeat.

• If the arpeggiator sequence consists of a 3 note cycle (1 - 2 - 3), Type is set to Up, and
Inversion is set to 2, the Arpeggiator output is 1 - 2 - 3 – (2 - 3 - 1 octave up) - (3 - 1 - 2 octave
up) - repeat.

Range Parameters
The RANGE parameters Min. Key and Max. Key allow you to change the range of keys that trigger
the arpeggiator sequence.

Range Min. Key
The first RANGE parameter, Min. Key, is only available in Arp mode. Min. Key sets the lowest key
that can be used as an input for the arpeggiator sequence.

The Arpeggiator can still generate pitches below the Min. Key setting.

Range Max. Key
The second RANGE parameter, Max. Key, is only available in Arp mode. Max. Key sets the highest
key that can be used as an input for the arpeggiator sequence.

The Arpeggiator can still generate pitches above the Max. Key setting.

Hold Parameter
The HOLD On/Off parameter is available in both Arp and Note Repeat mode. The Hold feature
allows you to latch the notes played by the Arpeggiator. When HOLD On/Off is active, the
Arpeggiator will continuously play a sequence according to the last pressed keys on the keyboard.

• Pressing any key while HOLD On/Off is active will set a new sequence.

• To stop the Arpeggiator playback, deactivate HOLD On/Off.
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Alternatively, you can switch the Arpeggiator completely off to stop playback. When
you switch the Arpeggiator back on, HOLD On/Off will still be active and you can
continue to play latched note sequences with the Arpeggiator.
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8. Automation and MIDI Control
Komplete Kontrol offers MIDI control and DAW automation features for easy integration with your
MIDI environment. This section provides general information about MIDI communication and DAW
automation, describes how to map third-party controllers to Komplete Kontrol, and explains the
MIDI Assignment Editor in detail.

Incoming MIDI
Komplete Kontrol and the Instruments you load inside it can be controlled via MIDI and the DAW
(when Komplete Kontrol is loaded as a plug-in):

• Triggering Instruments via MIDI notes: By default, incoming MIDI notes trigger the loaded
Instrument and will also be visually reflected by the Light Guide.

• Controlling parameters via DAW automation: You can control parameters of both
Komplete Kontrol and your loaded Instruments via DAW automation (when Komplete Kontrol is
loaded as a plug-in).

For more information on DAW Automation, refer to Host Automation.

Receiving MIDI Clock
Komplete Kontrol does not receive MIDI Clock. However, when using Komplete Kontrol as a plug-in,
it is automatically synchronized to the DAW tempo. The tempo display in Komplete Kontrol’s
header is grayed out and tempo is adjusted in the DAW.

Outgoing MIDI
Komplete Kontrol outputs the MIDI notes generated by the Scale engine and the Arpeggiator
through the MIDI outputs of the stand-alone application as well as the plug-in. You can route the
MIDI notes to other MIDI instruments or record them as a MIDI pattern in the DAW.

MIDI output is only supported by the stand-alone application as well as the VST, VST3
and AAX versions of the plug-in. The AU (Audio Unit) version of the plug-in does not
support MIDI output.

Host Automation
When you load Komplete Kontrol as a plug-in in a host, the parameters of the loaded Instrument,
the Scale parameters, and the Arpeggiator parameters can be automated from the host.

Recording Automation
Once your host is set up to record automation you can perform the following actions in the
software as well as from the keyboard:

• You can activate or deactivate Scale and Arpeggiator functions by clicking individual buttons in
the software or by pressing the corresponding buttons on the keyboard.

• You can select values of parameters by turning individual knobs in the software or on the
keyboard.
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For detailed information about recording automation in your host, refer to the
documentation of your host software.

Some hosts allow you to handle automation by using automation IDs that are mapped to specific
parameters of the plug-in. Komplete Kontrol comes with a predefined list of automation IDs which
allows the host find them automatically.

Automation IDs for the Perform Panel
The following automation IDs are reserved for parameters in Komplete Kontrol’s Perform panel:

Automation ID Parameter
000 Reserved for Instance Recognition and Automatic Focus Follow

001 Scale On / Off

002 Root Note (Scale)

003 Scale Type (Scale)

004 Key Mode (Scale)

006 Chord Mode (Scale)

007 Chord Type (Scale)

026 Arp On / Off

027 Mode (Arp)

028 Type (Arp)

029 Rate (Arp)

030 Sequence (Arp)

031 Swing (Arp)

032 Octaves (Arp)

033 Dynamic (Arp)

034 Gate (Arp)

035 Retrigger (Arp)

036 Repeat (Arp)

037 Offset (Arp)

038 Inversion (Arp)

039 Min. Key (Arp)

040 Max. Key (Arp)

041 Hold (Arp)

Mapping MIDI Controls to Third-Party Controllers
MIDI Mapping enhances the user experience and provides more control over sound, workflows
and performance. Komplete Kontrol keyboards are ready-mapped to the software. Third-party
keyboards and controllers can also be used to control some of the parameters in the Komplete
Kontrol software. These parameters include the eight knobs of the Native Map, parameter page
switching, preset switching and plug-in switching.
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Setting up a Third-Party Controller
To map a third-party controller to the Komplete Kontrol software:

1. Connect your third-party controller to your computer.

2. Start Komplete Kontrol.

3. Open the Preferences dialog, and select the MIDI tab.

4. Click the checkbox next to the corresponding name of the third-party controller.

→ The third-party controller is now ready to be used.

Assigning Knobs to a Third-Party Controller
To map a knob on your third party controller to Komplete Kontrol:

1. Click MIDI in the panel header of the software, to open the MIDI Learn panel.

2. Select a MIDI Learn knob in the software and then turn a knob on your keyboard.

3. It is now connected and the knobs should move in line with each other.

4. To map the remaining knobs, repeat this process.

MIDI Learn – Knobs page.

Assigning Buttons to a Third-Party Controller
You can also map buttons on your third-party controller to the software. This will allow you to
select another page of eight control knobs in the software using your keyboard. You can assign
MIDI CCs to move between parameter pages and switch between presets. To map a button to your
keyboard:

1. Click MIDI in the panel header of the software.

2. Select the Buttons tab.

3. Select a button in the software and then press and button on you keyboard.

4. It is now connected and the button should act in accordance with the software.

5. To map the remaining buttons, repeat these steps.

MIDI Learn – Buttons page.
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Enabling Takeover Mode Pickup for Knobs to prevent Parameter Jumps
When switching parameter pages, it can happen that knob positions in the software do not match
with the knob positions on your third party MIDI controller. To prevent potential parameter jumps,
you can enable the Takeover mode Pickup in the Preferences page MIDI.

Takeover mode option on the MIDI page in the Preferences.

When Pickup is activated, turning the knobs on your third party MIDI controller will only change
the value of the corresponding parameter, when the knob pointer reaches (picks up) the respective
value in the software. Komplete Kontrol highlights the difference between the knob positions using
white circles around the knobs in the Plug-in panel. The white circle indicates the knob position in
the software. The knob pointer indicates the position on the hardware.
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Differences between knob positions in the software and on the hardware.

Hardware Configuration for MIDI Mapping
When using the MIDI mapping feature in Komplete Kontrol, a MIDI button can be configured to
send a CC message on push and also on release. This mode is referred to as ‘Toggle’ mode. A
MIDI button can also be configured to send a single message when it is clicked, as opposed to
the two that are sent in Toggle mode. This mode is referred to as ‘Trigger’ mode. To use the MIDI
mapping functionality with a third-party controller, you must configure your third-party controller to
use Trigger mode.

Share Mapping Across Instances
You need to map your keyboard to Komplete Kontrol only once and you can then instantiate new
instances of the software, and the mapping will continue working across all of them.

Instances that are already open as the mapping is changed, will not receive the new
mapping automatically; for them to be updated to the new mapping you must close
your DAW and reopen it.

Setting up a Third-Party Controller
To map a third-party controller to the Komplete Kontrol software:

1. Connect your third-party controller to your computer.

2. Start Komplete Kontrol.
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3. Open the Preferences dialog, and select the MIDI tab.
4. Click the checkbox next to the corresponding name of the third-party controller.

→ The third-party controller is now ready to be used.

Assigning Knobs to a Third-Party Controller
To map a knob on your third-party controller to Komplete Kontrol:

1. Click MIDI in the panel header of the software, to open the MIDI Learn panel.
2. Select a MIDI Learn knob in the software and then turn a knob on your keyboard.
3. It is now connected and the knobs should move in line with each other.
4. To map the remaining knobs, repeat this process.

MIDI Learn – Knobs page.

Assigning Buttons to a Third-Party Controller
You can also map buttons on your third-party controller to the software. This will allow you to
select another page of eight control knobs in the software using your keyboard. You can assign
MIDI CCs to move between parameter pages and switch between presets. To map a button to your
keyboard:

1. Click MIDI in the panel header of the software.
2. Select the Buttons tab.
3. Select a button in the software and then press and button on you keyboard.
4. It is now connected and the button should act in accordance with the software.
5. To map the remaining buttons, repeat these steps.

MIDI Learn – Buttons page.

Enabling Takeover Mode
When you switch parameter pages, it can happen that knob positions in the software mismatch
with the knob positions on your third-party MIDI controller. To prevent potential parameter jumps
when turning the knobs, you can enable Takeover mode by selecting Pickup in the Preferences
page MIDI.
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Takeover mode option on the MIDI page in the Preferences.

When the Takeover mode is activated, turning the knobs on your third-party MIDI controller will
only change the value of the corresponding parameter, when the knob pointer reaches (picks up)
the respective value in the software. Komplete Kontrol highlights the difference between the knob
positions with white circles around the knobs in the Plug-in panel. The white circle indicates the
knob position in the software. The knob pointer indicates the position on the hardware.
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Differences between knob positions in the software and on the hardware.

Hardware Configuration for MIDI Mapping
When using the MIDI mapping feature in Komplete Kontrol, a MIDI button can be configured to
send a CC message on push and also on release. This mode is referred to as ‘Toggle’ mode. A
MIDI button can also be configured to send a single message when it is clicked, as opposed to
the two that are sent in Toggle mode. This mode is referred to as ‘Trigger’ mode. To use the MIDI
mapping functionality with a third-party controller, you must configure your third-party controller to
use Trigger mode.

Share Mapping Across Instances
You need to map your keyboard to Komplete Kontrol only once and you can then instantiate new
instances of the software, and the mapping will continue working across all of them.

Instances that are already open as the mapping is changed, will not receive the new
mapping automatically; for them to be updated to the new mapping you must close
your DAW and reopen it.
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9. Preferences
In the Preferences you can specify various settings for Komplete Kontrol.

To open the Preferences:

▶ Click Edit > Preferences in the Komplete Kontrol menu:

Preferences – Audio Page
The Audio page holds settings related to your audio interface when Komplete Kontrol is running as
a stand-alone application.

When using Komplete Kontrol as a plug-in, the audio configuration is managed by the
host, and the Audio page is not available.

The Routings section allows you to configure the connections between the virtual outputs of
Komplete Kontrol and the physical outputs of your audio interface.

Setting Description
Driver Here you can select the audio driver.

Device This allows you to choose from the available devices if you have connected
more than one audio interface.

Status This shows you whether your audio interface is currently running.

Sample
Rate

This displays the selected sample rate of your audio interface. Please restart
Komplete Kontrol after changing the sample rate.

Buffer Size macOS: This slider allows you to adjust the buffer size of your audio interface
in samples. Lower values result in a more immediate playing response but
increase the CPU load, and may result in audible clicks and pops. Larger values
decrease the CPU load but introduce a larger latency (a small delay between
hitting a pad and hearing it). It is recommended to find the lowest value that
does not cause clicks and pops even when playing more demanding Products.

Windows: When using an ASIO driver, the Audio page shows an ASIO Config
button instead of the Buffer Size slider. Click this button to open the settings
window of the selected ASIO driver.
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Setting Description
Latency This shows the delays introduced by the current Buffer Size setting.

Routings Under Routings, you will be presented with a list of the 16 stereo outputs from
Komplete Kontrol: In the right column, you can assign them to the outputs of
your audio interface. Click the fields in the right column to select the desired
outputs via a drop-down menu.

Preferences – MIDI Page
The MIDI page allows you to set up the MIDI input and output ports that you want to use when
Komplete Kontrol is running as a stand-alone application.

When using Komplete Kontrol as a plug-in, the MIDI configuration is managed by the
host, and the MIDI page is not available.

Element Description
Input Clicking Input displays a list of all the available MIDI inputs of your system. You

can activate/deactivate each input by clicking the checkbox next to its name.

Output Clicking Output displays a list of all the available MIDI outputs of your system.
You can activate/deactivate each input by clicking the checkbox next to its
name.

Takeover
Mode

When using third-party controllers, you can select Pickup from the Takeover
mode drop-down menu to prevent potential parameter jumps caused by
mismatching knob positions between software and hardware. For more
information, refer to Enabling Takeover Mode.

The MIDI Output settings are required for using Komplete Kontrol’s Smart Play features with other
MIDI instruments.

Preferences – General Page
The General page holds Usage Data Tracking settings. Usage Data Tracking technology enables
Komplete Kontrol to automatically track anonymous usage data that you can choose to share with
us.

Usage Data Tracking can be activated or deactivated in the General page of the Preferences in the
Komplete Kontrol software. However, we encourage all users to keep Data Tracking activated as
it provides a valuable tool for understanding the performance of Native Instruments applications
when they are used in real life situations. The data sent to Native Instruments is one hundred
percent anonymous and will not affect performance.

For more detailed information about Usage Data Tracking, please refer to the following Knowledge
Base article on the Native Instruments website: https://support.native-instruments.com/hc/en-us/
articles/209545029

Enabling or Disabling Usage Data Tracking
To enable or disable Usage Data Tracking:

1. Open the General page of the Preferences by clicking Preferences… in the Komplete Kontrol
menu.
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2. Click the Allow usage data tracking checkbox to enable or disable user data tracking.

Preferences – Library Page
The Library page allows you to edit the locations of all Komplete Kontrol Library files (both Factory
and User) that appear in the Library pane of the Browser.

At the top of the page, the Factory and User buttons allow you to switch between the Factory pane
and the User pane.

Factory Pane
The Factory pane shows all factory libraries available. These libraries will appear in the Factory
view of the Browser’s Library pane.

Element Description
Location column Shows the path of each library. If you have moved any library to another

location on your computer, click the folder icon on the left of that library
and select its new path.

Product column Shows the name of each product. These names cannot be edited.

Rescan button If you have made any change to a library (e.g., changed its location), select
it in the list and click the Rescan button to rescan that library.

User Pane
The User pane shows all user libraries currently used. These include Komplete Kontrol’s standard
user directory as well as any other user directory you might have defined. These libraries will
appear in the User view of the Browser’s Library pane.

Element Description
Location
column

Shows the path of each library. If you have moved any library to another
location on your computer, click the folder icon on the left of that library and
select its new path.

Alias column Shows the alias stored for each library. Click an alias to edit it. Defining
aliases for your user folders is not mandatory, but it can be of great help
when working on different computers (see description below). After adding
a location (see Add below), click the field in the new row and in the Alias
column to set the alias for that new location. The alias of the default user
folder, Native Instruments User Directory, cannot be edited — this is the
location where all your user files will be stored by default.

Scan user
content for
changes at
start-up

Enabled by default, this option automatically detects any new added user
content when starting Komplete Kontrol.

Add button Click Add to manually add directories to the user library. See below for more
details.

Remove button Click Remove to remove the selected user library. Files will only be removed
from the Komplete Kontrol Browser, not from your hard disk.

Rescan button If you have made any change to a library (e.g., added/removed files), select
it in the list and click the Rescan button to rescan that library.
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You can resize the Preferences panel at your convenience using the usual method on
your operating system. You can also resize each column by clicking and dragging the
limit between both column headers.

Adding Folders to the User Library
In the User pane of the Library page, you can add other folders to the user content of your
Komplete Kontrol Library. To do this:

1. Click Add at the bottom of the pane. A folder selection dialog opens up.

2. In the dialog, navigate to the desired folder on your computer and click OK (Choose on macOS).

→ All Komplete Kontrol-compatible files found in the selected folder are added to your user
content in Komplete Kontrol.

Komplete Kontrol-compatible files include ens, rkplr, nrkt, nksn, nfm8, nabs, nki,
nmsv, nbkt, nis.

Furthermore, the attributes (Instrument/Bank/Sub-Bank, Type/Sub-Type/Characters tags, as well
as properties) of all imported files will be retained.

By adding a folder to the user content of your Komplete Kontrol Library, you make their files
available in the Browser’s Library pane for quick searching and loading.

Paths to folders added via the IMPORT button in the Browser’s Files pane will also
show up here. The only difference between adding folders via the Add button in
Preferences panel described here, and via the IMPORT button in the Files pane of the
Browser is that the latter allows you to directly tag the files as they are imported.

Note that the selected folder cannot contain, or be contained within, a folder already listed in the
User or Factory pane. If Komplete Kontrol detects such a folder as you press OK (Choose on
macOS) in the folder selection dialog, a Duplicate Location message appears: Click OK to return to
the folder selection dialog and select another folder on your computer.

Removing Folders from the User Library
You can also remove any user folder from your library—except the default user content directory
Native Instruments User Content.

Preferences – Plug-ins Page
The Plug-ins page allows you to manage your VST plug-ins in Komplete Kontrol.

At the top of the page, the Manager and Locations buttons allow you to switch between the
Manager pane and the Locations pane.

Manager Pane
The Manager Pane allows you to view and manage all VST plug-ins available in Komplete Kontrol.
By default, all available plug-ins are activated for use in Komplete Kontrol.

PREFERENCES 66



▶ To deactivate a plug-in for use in Komplete Kontrol, click on the checkbox icon next to its name
so it is unchecked.

The option to Always use latest version of NI Plug-ins selects whether or not your Library content
is always loaded with the latest version of the associated plug-in. If this option is deactivated, your
Library content is loaded with the lowest required version of the associated plug-in found on the
computer.

For example, this option is required if you have installed both the full version of
Reaktor 5 as well as a Komplete Instrument that came with Reaktor 6 Player. By
disabling the option, the Reaktor 5 Factory Library will be loaded with the full version of
Reaktor 5, while the Komplete Instrument will be loaded with Reaktor 6 Player. This is
necessary since the Reaktor 5 Factory Library is not authorized for use with Reaktor 6
Player.

Element Description
Checkbox column Activates or deactivates a plug-in for use in Komplete Kontrol.

Plug-in column Lists all available VST plug-ins in Komplete Kontrol.

Always use latest
version of NI Plug-
ins

If this option is activated (default), Library content is loaded with the
latest version of the associated plug-in.

If this option is deactivated, Library content is loaded with the lowest
required version of the associated plug-in.

Locations Pane
The Locations pane allows you manage the folders containing your plug-ins on the hard drive.
Komplete Kontrol scans these folders for VST plug-ins and adds them to the Manager pane.
You can Add and Remove folders from the list, as well as use the Rescan function to update
the available plug-ins in Komplete Kontrol according to any changes made to the folders or their
contents.

▶ To display the Locations pane, click the Locations button at the top of the Plug-ins page.

Setting Description
Plug-in column Lists all folders that Komplete Kontrol scans for VST plug-ins.

Add Opens a file dialogue that lets you add another folder to the list.

Remove Removes the selected folder from the list.

Rescan Scans all folders in the list for compatible plug-ins and updates the
Manager pane accordingly.

Preferences - Features Page
Using the Features page, you can enable different configurations of Komplete Kontrol. Whenever a
feature toggle is activated or deactivated, the software must be restarted for the changes to take
effect.

Element Description
Browser Tag Remapping Remaps the tags found in the Browser
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